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I. [bookmark: _Toc207024862][bookmark: _Toc207024872]Introduction
1.1 Software Background Introduction
[bookmark: _Toc207024860]In recent years, with the rapid advancement of synthetic biology and computational biology, microbial cell factories have emerged as a major focus for the production of plant natural products. However, plant-derived enzymes often exhibit poor thermal stability and reduced catalytic efficiency when expressed in heterologous hosts, which directly compromises the feasibility of industrial-scale production. Conventional enzyme engineering approaches, such as directed evolution and random mutagenesis, rely heavily on large-scale experimental screening, requiring significant time and effort while lacking the ability to accurately predict mutation outcomes. Consequently, rational design strategies informed by computational methods and structural biology have become increasingly important for enhancing enzyme performance and stability.
Despite these advances, most existing rational design tools demand substantial expertise in computational and structural biology, require significant computational resources, and are characterized by complex, non-intuitive interfaces. These limitations raise the barrier to entry, restricting accessibility for early-career researchers and interdisciplinary users. Hence, there is an urgent need for a software tool that combines intuitive design, ease of deployment, and high precision to support efficient enzyme rational design.
To meet this need, we developed REvoDesign.
1.2 Software design purpose and scope of application
[bookmark: _Toc207024861]REvoDesign (Rational Evolutionary-involved enzyme redesign workflow) is a semi-rational design platform developed for the rational engineering of natural enzymes. It is designed to streamline the mutation design process and improve both efficiency and success rates. The software integrates a suite of advanced computational modules, including protein structure prediction and optimization, evolutionary analysis, cross-validation, and mutation visualization. These functions enable users to design functional enzyme variants with high precision, even within limited experimental capacity, thereby enhancing critical industrial properties such as thermal stability, catalytic efficiency, expression yield, and solubility.

The software is intended for:
· Researchers working in enzyme engineering, biocatalysis, and synthetic biology;
· Laboratories with limited experimental resources seeking to efficiently obtain optimized enzyme variants through rational design;
· Early-career researchers and students from interdisciplinary backgrounds, providing a rapid entry point into enzyme rational design experiments;
· Biotechnology companies requiring efficient mutation design, validation, and protein performance optimization.
1.3 Main features of the software
Key Features of REvoDesign Software:
· Intuitive Graphical Interface: Deeply integrates the PyMOL visualization suite as a plugin, offering a clear and user-friendly interface.
· Efficient Mutation Design and Evaluation Workflow: Automated identification of hotspot regions and design of mutants, combined with visual evaluation of variants, enhances design efficiency.
· Integration of Evolutionary Information and Rational Decision Framework: Utilizes co-evolution analysis tools (e.g., GREMLIN) and evolutionary conservation data (e.g., PSSM) to guide design strategies and reduce ineffective mutations.
· Low Computational Resource Requirements and High Compatibility: Supports major operating systems (Windows, Linux, MacOS) with minimal computational demands, making it easy to deploy.
· Modular and Highly Extensible: Modular interfaces allow integration with third-party design tools (e.g., ProteinMPNN, DLPacker, Rosetta), enabling flexible configuration based on user needs.
· Advanced Feature Integration with High Flexibility: Offers multi-tool cross-screening, mutant clustering analysis, and advanced parameter configuration, catering to users with varying expertise levels.
· Real-time Visualization and Interactive Analysis: Visualization and evaluation tools support real-time interactive analysis to help users make quick decisions and plan experiments.
· Comprehensive Exception Handling and Fault Management: Built-in mechanisms for error capture and handling reduce operational mistakes and enhance user experience.
II. Software installation and deployment
2.1 Supported Operating Systems and Hardware/Software Environment
REvoDesign software can run on the following major operating systems:
· Windows 10 or later
· Ubuntu Linux 20.04 or later
· macOS 12 or later
The basic hardware and software requirements are as follows:
	Requirements
	Recommended configuration

	Architecture
	Win-64; Linux-64; OSX-64; OSX-arm

	Hard Drive
	Basic: 8 GB or higher

	Memory
	Basic: at least 2 GB; Recommended: 16 GB

	Display
	Resolution: 1920×1080 or higher

	Software dependencies
	PyMOL Insentive (2.5.7 and above; 3.0.2 and above), not recommended for Apple Silicon with REvoDesign Extra tools; or
PyMOL open-source (2.5.0 and above; 3.1.0 and above); or
Python (3.9-3.12) if installed everything manually


2.2 Software Installation Steps
2.2.1 Installing PyMOL
Using REvoDesign requires a basic familiarity with PyMOL. Users can install a separate version of PyMOL specifically for REvoDesign. If a usable PyMOL installation already exists, this step can be skipped. This tutorial recommends installing a Conda environment management tool such as Miniconda or Anaconda and then installing the open-source version of PyMOL via the Conda-forge channel. The installation steps are as follows:
1. Go to the Anaconda Miniconda page and follow the official instructions to download and install Miniconda. It is recommended to install via the command line: https://www.anaconda.com/docs/getting-started/miniconda/install.
2. Create a new Conda environment: `conda create -y -n REvoDesign python=3.11`
3. Activate the newly created Conda environment: `conda activate REvoDesign`
4. Install the open-source version of PyMOL: `conda install -y -c conda-forge pymol-open-source`
5. Launch PyMOL: `pymol`
2.2.2 Using the Graphical Installer
REvoDesign provides a convenient graphical installer. The installation steps are as follows:
1. Download and Install the REvoDesign Package Manager
1.1. Download the REvoDesign Package Manager and Installation Package
On the official REvoDesign repository page (https://github.com/YaoYinYing/REvoDesign), follow the instructions to obtain the link for the REvoDesign Package Manager:
https://gist.githubusercontent.com/YaoYinYing/c1e8bfe0fc0b9c60bf49ea04a550a044/raw/REvoDesign_PyMOL.py.
In the Releases section on the right, click to download the latest installation package file, typically a compressed file with a .zip or .tar.gz extension.
1.2. Install the REvoDesign Package Manager as a PyMOL Plugin
1. Open the installed PyMOL software.
2. Click the menu bar: Plugin → Plugin Manager.
3. In the popup window, click the Install New Plugin button.
4. Under the Install from PyMOL Wiki or any URL section, paste the link to the REvoDesign Package Manager into the URL field and click Fetch on the right.
5. In the popup window, click Yes to confirm the installation.
6. In the new popup window, confirm the installation location for the plugin—usually, the default location is fine—and click OK.
7. After installation is complete, the Plugin menu in PyMOL will automatically show the entry REvoDesign Package Manager.
[image: 图形用户界面, 文本, 应用程序

AI 生成的内容可能不正确。]Figure 1. PyMOL plugin manager interface
[image: 图形用户界面, 应用程序

AI 生成的内容可能不正确。]Figure 2. Fill in the REvoDesign package manager link to install
[image: 图片包含 表格

AI 生成的内容可能不正确。]
Figure 3. Confirm the plug-in installation location
2. Installing REvoDesign and Its Components via the REvoDesign Package Manager
2.1 In PyMOL, open the Plugin menu and select REvoDesign Package Manager.
2.2 In the Source section, choose Local file as the installation source. The text box below will become editable.
2.3 Click the … button to the right of the installation source input field, and in the file browser, select the downloaded installation package file with a .zip or .tar.gz extension. After confirmation, the full file path will appear in the text box. Note that you need to select the installation source each time you install.
2.4 If needed, configure network settings in the Network section, such as using a network proxy or specifying a PyPI mirror.
2.5 In the Extra section, choose whether to install optional components:
· None: Do not install any optional components.
· Customized: Check this option to expand the component list on the right and select the components you want to install.
· Everything: Install all components except for the test suite.
For the first installation, it is recommended to select None. After the initial installation is successful, optional components can be installed separately.
2.6 Click Install. The installer will automatically download and install all required dependencies and the selected components.
[image: ]
Figure 4. Once the package manager is installed, you can find its entry on the PyMOL menu bar.
[image: 图形用户界面, 文本, 应用程序

AI 生成的内容可能不正确。]
Figure 5. Package manager interface
3. Confirming Installation Completion
3.1 After installation is complete, a dialog box will appear to confirm the installation results.
3.2 If the installation is successful, restart PyMOL. You should then see the REvoDesign entry in the Plugin menu.
3.3 If the installation fails, check the detailed error messages in the PyMOL command prompt. Users in mainland China may need to adjust network settings before clicking Install again.
4. Self-Upgrade of the REvoDesign Package Manager
4.1 In a blank area of the REvoDesign Package Manager, right-click to open a menu.
4.2 Click Upgrade this manager to update the manager’s interface files and Python program files online. Each update will compare the current files with the new ones and notify the user of differences via a popup. Users should carefully review the changes and click Yes to confirm the update.
4.3 The updated package manager will take effect the next time PyMOL is launched.
4.4 Note that due to PyMOL’s plugin management system, different PyMOL installations may have their own instances of the package manager already installed.
[image: 图形用户界面, 文本, 应用程序

AI 生成的内容可能不正确。]
Figure 6. Package Manager right-click menu
5. Diagnostic Data Collection in the REvoDesign Package Manager
5.1 When encountering issues, users can use the diagnostic data collection feature in the package manager to gather necessary information.
5.2 In a blank area of the REvoDesign Package Manager, right-click to open a menu.
5.3 Options beginning with Collect diagnostic data represent three levels of data collection:
· reduced: minimal data collection.
· full, non-sensitive: complete data collection with sensitive information filtered as much as possible.
· full, with sensitive: complete data collection without filtering sensitive information.
In most cases, choose one of the first two options.
5.4 After clicking to collect data, the information is automatically copied to the user’s clipboard.
5.5 Paste the data into a text editor for review or sharing.
[image: 图形用户界面, 文本, 应用程序, 聊天或短信

AI 生成的内容可能不正确。]
Figure 7. Diagnostic data collection
In addition to copying to the clipboard, you can also search for the details in the pop-up message box.
6. Resetting REvoDesign Configuration Files via the Package Manager
6.1 If incorrect configurations prevent REvoDesign from starting normally, the configuration files can be reset within the package manager.
6.2 In a blank area of the REvoDesign Package Manager, right-click to open a menu.
6.3 Click Reset REvoDesign’s configuration to open a dialog box confirming the reset request.
6.4 When the user clicks Yes to confirm, the existing configuration folder will be deleted, and a new configuration folder will be copied from the REvoDesign program directory.
6.5 After the reset is complete, restart PyMOL to apply the configuration changes.
7. Other Options
7.1  Installation Source
· Repository: Fetch the installation files directly from the GitHub repository.
· Local Directory: Use a locally cloned project repository or a folder containing an already extracted installation package.
7.2 Installation Options
7.2.1 Verbose: Controls the log output level during installation.
· Rightmost: completely off.
· Middle: normal log information.
· Leftmost: full, detailed debug logs.
· If the installation fails, switch to the leftmost setting to obtain the most complete installation logs for troubleshooting.
7.2.2 Tag: Displays all version tags in the remote project repository. Enabled only when the installation source is Repository.
7.2.3 Commit: Allows specifying a custom commit hash, branch name, or version tag in the remote repository. Enabled only when the installation source is Repository.
7.3 Optional Component Options
Refresh: Refresh the list of installable components. Use this if the list fails to populate automatically when opening the package manager.
7.4 Cache Options
Specify a cache location for the installed REvoDesign. The path will be written to the user configuration file. Unless disk space is limited, usage is not recommended.
7.5 Right-Click Menu
Refresh GitHub Release tags: Refresh the Tag options in the installation settings.

III. Detailed explanation of software functional modules
In this tutorial, we will use a structure from the RCSB PDB (PDBID: 1SUO) as an example.
3.1 Interface display[image: ]
Figure 8. Basic functional divisions of the REvoDesign main interface
Main Interface of REvoDesign
The REvoDesign main interface is divided into the following functional areas:
1. Molecule and Chain Selection Area: Visible after loading a molecule.
2. Processor Core Usage Constraint Area: The maximum value corresponds to the number of available cores in the current system.
3. Color Preset Area: Used for result rendering and display. The adjacent checkbox allows inverting the preset definitions.
4. Core Functional Module Area: The main operational region, organized into tabs according to function and workflow.
5. Progress Bar: Indicates task status.
· During background computations, the progress bar scrolls.
· During design, it shows computation progress.
· During rational screening, it indicates the position of the current item within the overall set (e.g., the position of a mutant within the full mutant tree, or a co-evolutionary residue pair within the full pair queue).
6. Tooltip Area: Hovering the mouse pointer over a control displays usage annotations.
In addition to color configuration, the Color Preset Area also provides a preset display, visually presenting the color spectrum of each preset. The direction from the top-left to the bottom-right represents the transition of values from low to high. The default preset is bwr_r, which transitions from red → white → blue.
[image: ]

Figure 9. The color preset area has a drop-down list and a color preview icon.
In addition, some peripheral auxiliary design tools are distributed in the drop-down menu and classified according to their functions.
[image: ]
Figure 10. The dropdown menu provides additional task functions.
For example, the “Relax w/ Ca Constraints” function under Tools → Rosetta performs iterative optimization of side chains while keeping the protein backbone fixed. The popup window collects user input configurations, such as the PDB file path, the number of structures to optimize per iteration, the number of iterations, the save path, and other parameters.
[image: ]
Figure 11. The task parameter window pops up from the drop-down menu, guiding the user to enter the corresponding calculation parameters.

The input parameters in the task window are not part of the core configuration, so they will not be saved when the window is closed. If users need to repeat an experiment, they should save the parameters after entering them, making it easier to reuse them in subsequent calculations.
Task parameters can be loaded by clicking Load or quickly loaded by dragging the parameter file into the window.
[image: 图形用户界面, 应用程序

AI 生成的内容可能不正确。]
Figure 12. The calculation parameter configuration in the task window can be saved as a JSON file and can also be loaded again by dragging and dropping

In addition, REvoDesign supports international translation, but only for the main window. Other areas, such as notes in the log and task windows, are still in English.
[image: ]
Figure 13. Interface language switching
[image: ]
Figure 14. Chinese user interface
Any inputs or changes made in the main window can be saved as an experiment, facilitating reuse and repeated calculations.
[image: ]
Figure 15. Configuration files can be loaded and saved as example experiment configurations.

[image: ]
Figure 16. Saving the configuration
Any changes made in the user interface directly modify the configuration information in memory but are not saved to disk. Only by clicking Save Configuration will the changes be saved and loaded the next time the program starts.
· Initialize Configuration: Clears the user’s current configuration files and copies a fresh, complete set from the program directory.
· Edit Configuration: Opens the configuration file in the user’s browser for manual editing via the configured editor.
· Direct modifications to the configuration file will not be reflected in the program window. To apply a modified configuration file, click Reload Configuration.
· If the program fails to start due to incorrect configurations, the configuration can be reset via the right-click menu in the package manager.

3.2 [bookmark: _Toc207024875]Evolutionary data analysis
REvoDesign requires searching sequence databases to compute conservation information (PSSM) and co-evolution information (GREMLIN). Because these sequence databases are large, we separated this functionality and implemented it as a simple web-based computation service. Laboratories with the proper resources can deploy their own instance of the website following the provided setup guide.
Using our laboratory’s instance as an example, users need to submit the target protein sequence for queued computation. The submission URL is:https://revodesign.yaoyy.moe/PSSM_GREMLIN/create_task
A reviewer-only access is provided by using this account: 
Account: reviewers
Password: 73C3fx7NMAhD4rTQDTpkwsnjzborTTFe
Note: The computation service does not enforce input sequence format. Users must provide sequences in strict FASTA format, with each file containing a single sequence. Unknown residues can be represented by X; stop codons (*) are not allowed. For example:
```text
>1SUO_A
XXXXXXXXXXXXXXXXXXXXXXXXXXXGKLPPGPSPLPVLGNLLQMDRKGLLRSFLRLREKYGDVFTVYLGSRPVVVLCGTDAIREALVDQAEAFSGRGKIAVVDPIFQGYGVIFANGERWRALRRFSLATMRDFGMGKRSVEERIQEEARCLVEELRKSKGALLDNTLLFHSITSNIICSIVFGKRFDYKDPVFLRLLDLFFQSFSLISSFSSQVFELFSGFLKYFPGTHRQIYRNLQEINTFIGQSVEKHRATLDPSNPRDFIDVYLLRMEKDKSDPSSEFHHQNLILTVLSLFFAGTETTSTTLRYGFLLMLKYPHVTERVQKEIEQVIGSHRPPALDDRAKMPYTDAVIHEIQRLGDLIPFGVPHTVTKDTQFRGYVIPKNTEVFPVLSSALHDPRYFETPNTFNPGHFLDANGALKRNEGFMPFSLGKRICLGEGIARTELFLFFTTILQNFSIASPVPPEDIDLTPRESGVGNVPPSYQIRFLARH
```
[image: ]
Figure 17. Submitting the sequence for calculation

On the submission page, select and upload the sequence file. After the upload is complete, the system will return the MD5 sum and the calculation status. A status of Still running indicates that the sequence has entered the computation queue.
Users can then go to the dashboard page and refresh to monitor changes in the computation status:
https://revodesign.yaoyy.moe/PSSM_GREMLIN/dashboard
[image: ]
Figure 18. The sequence calculation status is calculating

When the user finds that the upload sequence is incorrect, he can choose to cancel the queue or terminate the task being calculated.
[image: ]
Figure 19. A button to cancel calculation will appear when you hover the mouse pointer over a task in the calculation or queued state.
When the computation is complete, users can hover over the task block and click the Download button that appears to retrieve the results. The downloaded file is a ZIP archive.
[image: ]
Figure 20. Viewing and downloading evolutionary data calculation results
After the download is complete, decompress the compressed package for later use.
3.3 Prepare Module (Design Preparation Module)
3.3.1 Loading and Processing Structure Files
In PyMOL, users need to obtain a target structure for design. For example, fetch 1SUO retrieves the PDB structure used in this case. This is a CYP450 enzyme, which contains the following components:
	Segment ID
	Molecule
	Description

	A
	protein
	protein

	B
	HEM
	cofactors

	C
	CPZ
	Substrate molecules

	D
	HOH
	Crystallographic water


Before we begin, we perform structure and session preprocessing:
```pymol script
# Display alpha-helices in cartoon mode as cylinders
set cartoon_cylindrical_helices, 1
# Set cartoon color to gray
set cartoon_color, gray70
# Set cartoon transparency to 0.3
set cartoon_transparency, 0.3
# Assign secondary structure
dss
# Remove crystallographic water
remove resn HOH
# Set background color to white
bg_color white
```
Save this session, as it will serve as one of the starting files for our subsequent analysis and design.
To simplify the tutorial, no conformational relaxation or optimization will be performed on this structure.
[image: ]
Figure 21. Prepared Case Structure Model
Although the structure has been successfully loaded in PyMOL, it still needs to be loaded once in REvoDesign so that the program can recognize the molecules within the session. In the menu bar, select File → Import PyMOL Session, or use the shortcut Ctrl/Command + N to import the structure information.
[image: ]
Figure 22. Importing an existing Session in PyMOL
3.3.2. Identification of design hotspots in combined regions
In the Functional Pocket section of the Prepare tab, specify the substrate and cofactor molecules, set the maximum contact distance, and define the design hotspot region within the binding site.
This input field also allows custom, complex PyMOL selection strings (e.g., r. UNK or r. LIG to treat two ligands as a single entity).[image: ]
Figure 23. Specifying Substrate and Cofactor Molecules
For example, CPZ is the substrate molecule of 1SUO, and HEM is the cofactor. The default binding pocket cutoff distances are 8 Å for the substrate and 7 Å for the cofactor. Users can specify longer or shorter distances according to their design requirements.
[image: ]
Figure 24. Specifying Small Molecules, Hotspot Distance Criteria, and Save Path
Additionally, the Check button can only be enabled after specifying the session save path. Clicking the Check button loads the pocket results into the session and saves them to the specified location.[image: ]
Figure 25. Determination Results
The binding pocket determination results are saved in the pockets folder within the current directory, named as <molecule>_<pocket_selection>_residues.txt.
Since cofactors and substrates are usually in close proximity, during the region definition process, overlapping areas are assigned to the cofactor and subtracted from the substrate region.
	Pocket selection
	Content
	Illustrate

	design_shell_CPZ_8.0_01
	100,101,102,103,104,105,108,206,209
,218,365,477,478
	Substrate binding region, excluding the cofactor binding region

	pkt_cof_HEM_7.0_01
	88,95,96,97,98,113,114,115,116,121,125,
128,132,179,182,291,294,295,296,297,
298,299,300,301,302,303,304,305,306,
307,357,362,363,366,367,368,369,390,
392,427,428,429,430,431,432,433,434,
435,436,437,438,439,441,442,443,445,
446
	Cofactor binding region


	pkt_CPZ_8.0_01
	98,100,101,102,103,104,105,108,114,
115,206,209,218,294,295,296,297,298,
299,300,301,302,303,362,363,365,366,
367,368,428,429,434,436,437,438,439,
442,477,478
	Substrate binding region


	pkt_hetatm_8.0_01
	84,88,95,96,97,98,99,100,101,102,103,
104,105,108,112,113,114,115,116,117,
121,122,124,125,126,128,129,132,175,
178,179,182,183,206,209,218,291,294,
295,296,297,298,299,300,301,302,303,
304,305,306,307,353,357,361,362,363,
364,365,366,367,368,369,388,390,392,
396,427,428,429,430,431,432,433,434,
435,436,437,438,439,440,441,442,443,
445,446,477,478
	Combined substrate and cofactor regions



3.3.3. Determining Surface-Exposed Design Hotspot Regions
In the Surface Exposure section of the Prepare tab, surface-exposed design hotspot regions can be determined.
This function identifies solvent-exposed sites based on the solvent-accessible surface area of individual residues in 3D space. For example, residues with a surface area greater than or equal to 15 Å² are considered exposed sites.
Additionally, if surface-exposed regions are close to the substrate pocket, the substrate pocket region can be excluded. By clicking [Refresh Selection], the Exclusion dropdown menu displays a series of PyMOL selections, including those generated during the pocket hotspot identification step. Selecting pkt_hetatm_8.0_01 will exclude all residues in contact with heteroatoms.
For multimeric proteins, protein–protein interface (PPI) recognition can also be performed in this section. Set Chain Dist as the minimum PPI distance, and click [Find] to select inter-chain contact regions. These can also be loaded by clicking [Refresh Selection].
Note that exclusions can also be combined using PyMOL selection strings for more precise constraints.[image: ]
Figure 26. Surface-Exposed Region Options and PPI Region Determination Options
[image: ]
Figure 27. Enter Exclusion Options, Surface Area Threshold, and Save Location to Perform Surface Hotspot Search
The surface-exposure determination results are visualized in three parts: blue spheres represent exposed sites, red spheres represent buried sites, and sites without spheres are excluded.
The surface-exposure determination results are saved in the surface_residue_records folder within the current directory. The file contents are similar to those of the pocket determination results.
[image: ]
Figure 28. Surface-Exposed Region Determination Results
It should be noted that the session after surface-exposure determination is for visualization purposes only and should not be used for subsequent design or analysis.
3.3.4 Performing Constrained In Silico Saturation Mutagenesis in the Mutate Tab
· Surface Entropy Reduction Design
Surface Entropy Reduction (SER) design primarily replaces surface-exposed residues with shorter, simpler amino acids that have reduced solvent interactions, while applying conservation constraints at the site level.
Users need to load the extracted evolutionary data files into the Profile section and select the profile type as PSSM. In Residue ID, select the results from the surface site detection, and choose a session save location. In the [Score cutoff] area, set an appropriate PSSM score threshold. In the figure, this means that the PSSM value of the substituted residue relative to the wild-type residue should not be less than -2 and not greater than 20. (Since PSSM values are exponential, 20 represents an extremely high difference, effectively absolute conservation.)
In the Substitution section:
· Enter Reject as PC to exclude proline and cysteine substitutions.
· In Accept, specify substitution preferences in the format {residue to be replaced}:{candidate amino acids}. For example, E:DATY indicates that the selected glutamate (E) can be replaced with D, A, T, or Y.
Finally, enter a Design Case identifier, which will be used to name the generated intermediate files.
Note: The Run button is only enabled if the session file path is valid.
Click Run! to generate a pool of in silico saturated mutants under the specified constraints.
[image: ]
Figure 29. Settings for Surface Entropy Reduction Design
The design results are displayed in PyMOL as grouped entries. Groups are organized by design site number, with the format: mt_<WildType><ResidueNumber>_<WildTypePSSMScore>
Each group contains all possible point mutations for that site. Individual point mutations are named as: <ChainID><WildType><ResidueNumber><Mutant>_<MutantScore>
Only the mutated side chain is displayed in the structure; carbon atoms are colored according to the PSSM score. The full mutant structure PDB files can be found in the mutant_pdbs folder in the working directory.
[image: ]
Figure 30. Visualization of Surface Entropy Reduction Design Results
· Catalytic Pocket Design
The design of the catalytic pocket adopts a relatively flexible substitution strategy.
Users need to load the decompressed evolutionary data file into Profile, select Profile type as PSSM, and in Residue ID, choose the results of the catalytic pocket detection.
Then, specify a valid session save path.
In the Score cutoff section, set an appropriate PSSM score threshold.
The example in the figure shows that the PSSM value of the substitution residue, compared with the wild-type residue, should be no lower than –5 and no higher than 20 (since PSSM scores reflect logarithmic likelihoods, a value of 20 represents an extremely high difference, effectively indicating infinite conservation).
In the Substitution area:
· Set Reject to P C to exclude substitutions to Proline (P) and Cysteine (C).
· Clear any settings in Accept to allow broader substitution options.
Finally, in the Design Case field, enter a unique case name, which will be used as the basis for naming the generated intermediate files.
Compared to surface entropy reduction design, catalytic pocket design relaxes constraints on non-conservative substitutions, allowing greater diversity in the designed variants.[image: ]
Figure 31. Catalytic pocket design settings
[image: ]
Figure 32. Catalytic pocket design results display
3.3.5 Evaluate module (Rational Evaluation Module)
The Rational Evaluation Module is an auxiliary tool for manually inspecting mutant side-chain substitutions.
It provides real-time visualization of modeled mutant side-chain conformations on the main-chain structure, allowing comparison of structural and physicochemical differences before and after mutation.
In the Evaluate tab,
· the upper section specifies the save path for the selected mutants and the checkpoint loading entry;
· the lower section contains controls for switching mutant inspection (previous/next buttons) and making decisions (accept/reject buttons).
Note: If the save path is not specified, no mutant files or checkpoint files will be generated.[image: ]
Figure 33. Saving decisions and loading checkpoints in the Rational Evaluation module
In REvoDesign, mutants are organized into groups called a “mutant tree.”
Each branch appears in the first drop-down menu, and the current mutant appears in the second drop-down menu.
By selecting these two menus, users can navigate between branches and specific mutants.
Additionally:
· Find the Best Hit allows you to search for the highest-scoring mutant within the current branch.
· I’m Lucky! automatically scans all branches to locate the best-scoring mutant in the entire tree.[image: ]
Figure 34. Status display and decision-making tools in the Rational Evaluation module
The left side shows the total number of mutants and the number of selected mutants, while the right side provides tools to assist in inspection and decision-making.
Before performing rational inspection, users need to click “Initialize” to identify the mutant tree in the PyMOL session.
If the identification is successful, Total should display a non-zero positive integer, and the inspection and decision buttons on the right will be enabled.
Once REvoDesign enters the rational evaluation state, unrelated point mutations are hidden, irrelevant branches are collapsed, and only the currently selected branch and individual are displayed.
The visualization shows both stick-and-ball and mesh models of the mutant, alongside the wild-type side chain in a line model for comparison.
Before initialization, the first mutant in the first branch is displayed.[image: ]
Figure 35. Rational Evaluation State
Users can make rational decisions based on the side-chain visualization, comparing PSSM scores and side-chain substitutions to decide whether to accept, ignore (not accepted), or reject (previously accepted) a mutant.[image: ]
Figure 36. Selecting the Highest-Scoring Mutant[image: ]
Figure 37. Decision status updated after acceptance
Manual inspection typically uses the previous/next buttons for navigation and also supports keyboard shortcuts, improving efficiency when screening large numbers of mutants.
	Button
	Function
	Keyboard shortcut

	Previous
	Back
	[bookmark: _Hlk206174057]Shift+Opt+`[`

	Next
	Forward
	Shift+Opt+`]`

	Reject
	Reject
	Shift+Opt+`+`

	Accept
	Accept
	Shift+Opt+`-`


However, button navigation is linear and does not allow flexible jumping. In contrast, the drop-down menus provide a more efficient way to switch and select mutants.[image: ]
Figure 38. Selecting a Branch[image: ]
Figure 39. Selecting a Point Mutation within a Branch
“Find the Best Hit” automatically locates the highest-scoring mutant within the current branch, while “I’m Lucky” automatically searches for the top-scoring individual in each branch.[image: ]
Figure 40. Entering a Branch[image: ]
Figure 41. Clicking “Find the Best Hit” to Automatically Navigate to the Top-Scoring Mutant
[image: ]
Figure 42. “I’m Lucky” Automatically Searches for the Top-Scoring Mutant in 15 Branches
During rational screening, the user’s decisions are saved in real time to the specified text file.
At the same time, corresponding checkpoint files are generated, allowing historical decisions to be loaded later.
[image: ]
Figure 43. Real-Time Storage of Mutant Decision Results
[image: ]
Figure 44. Mutant Decision Checkpoints
[image: ]
Figure 45. Loaded Checkpoint Results
Before loading a checkpoint file, the mutant tree should be re-initialized to clear any previous screening results.
[image: ]
Figure 46. Log Display of Checkpoint Loading Results
3.3.6 Clustering
REvoDesign uses sequence clustering to classify similar point mutations and select representatives from each branch.
· When Mutate Relax evaluation is disabled, representatives are selected randomly.
· When enabled, selection is guided by Rosetta scoring.
Users need to:
· Load the previously saved point mutation list.
· Specify the number of mutations per mutant (default is 1).
· Set the number of clusters (must be less than the total number of mutants).
· Define the batch size for computation.
· Choose a scoring matrix (default is PAM30).
· Decide whether to perform additional energy evaluation using Mutate Relax, depending on computational needs and the local Rosetta setup.[image: ]
Figure 47. Sequence Clustering Calculation Settings
[image: ]
Figure 48. Sequence Clustering Results
The matrix on the right represents the pairwise sequence similarity between mutants, with darker colors indicating higher similarity.
Users should note that fewer clusters are not always better. When the number of clusters is too small, the scoring matrix may force completely different sequences into the same cluster, ignoring their diversity.
Additionally, users can choose to perform a quick energy evaluation of each point mutation within a branch using Rosetta.
[image: ]
Figure 49. Enabling Rosetta Quick Energy Evaluation in Clustering
During post-processing of clustering, REvoDesign uses Rosetta to generate quick point-mutation structures and evaluate their energetic stability.
[image: ]
Figure 50. Summary of Scoring Results in the Log Output
[image: ]
Figure 51. Mutate Relax Scoring Result File
The complete scoring results are saved as Excel and CSV files, facilitating subsequent analysis.
Note that Mutate Relax operates under three assumptions:
1. The original structure is already in an energy-minimized state.
2. Introducing a point mutation does not affect the backbone coordinates.
3. The mutation does not affect distant side-chain packing.
Under these assumptions, only the mutation is introduced, followed by a local repacking to adjust the side-chain conformations.
Therefore, having a well-optimized original structure is critical for the reliability of the scoring results of mutant structures.

3.3.7 Visualize Module
This module has two main functions:
1. Cross-data filtering of saved mutant lists, such as ddG, ESM1v, Cartesian ddG, MPNN, and other metrics.
2. Structural visualization of experimentally measured data within the 3D protein context.
· Cross-Filtering
In this tutorial, Pythia-ddG is used as an example. It is a structure-based tool for predicting the free energy change (ΔΔG) of point mutations.
Users can conveniently perform calculations on BioLib: https://biolib.com/YaoYinYing/pythia-wubianlab/.

Using Pythia-ddG is straightforward:
1. Upload the structure file.
2. Click “Run” and wait approximately one minute for the calculation to complete.
3. Download and unzip the results. The included CSV file serves as the reference data for this round of cross-filtering.
[image: ]
Figure 52. Example of Pythia-ddG Hosted on BioLib
[image: ]
Figure 53. Pythia-ddG Requires a PDB File as Input
[image: ]
Figure 54. CSV File Containing the Pythia-ddG Calculation Results for This Example

[image: ]
Figure 55. Example of Cross-Filtering
Load the point mutation list and specify a save location. Then, select the CSV output path from Pythia-ddG and set the Profile type to CSV (automatically detected, but manual confirmation is recommended).In the color preset area at the top right, check the option indicating that lower scores correspond to better mutants (e.g., for ddG, a value >0 indicates instability, so lower values are more favorable).In the display options at the bottom right, check Global Scoring, meaning that the color mapping considers extreme values across the entire CSV table.Finally, enter an appropriate Group name to generate a corresponding mutant tree for this dataset.
Additionally, for a small number of point-mutation side-chain modeling tasks, it is recommended to use high-performance side-chain modeling tools such as DLPacker. This ensures that side-chain conformations are modeled accurately and reasonably during cross-filtering, providing detailed structural information for subsequent manual inspection.


[image: ]
		Figure 56. Adjusting Side-Chain Solver Settings
[image: ]
Figure 57. Side-Chain Visualization During Cross-Filtering
[image: ]
Figure 58. Manual Inspection Step During Cross-Filtering
The red mutation, AE240Y, has a high energy and is one of the primary point mutations to exclude. Click on the right-side panel in PyMOL to hide AE240Y.
[image: ]
Figure 59. First Step in Pruning the Mutant Tree: Click to Hide
Use the “Reduce Session” button to remove point mutations from the interface. Then, rename the point mutation list and click “Save Mutant” to save the pruned mutant tree.
[image: ]
Figure 60. The Pruned Mutant Table No Longer Contains AE240Y
[image: ]
Figure 61. AE240Y is no longer in the mutant list after pruning.
· Visualization of Experimental Data on Structure
Assume the user has a set of experimentally measured data, saved in a CSV or Microsoft Excel file. The data format is as follows:
	mutant
	normalized
	group

	WT_1
	0
	control

	wt_2
	-0.1
	control

	WT
	0
	control

	AE93D
	0.1
	low

	AK191R
	0.2
	medium

	AQ204E
	0.3
	high


Here, mutant refers to the name of the point mutation, group is the classification used as the branch name in the mutant tree, and normalized is the measured score. Column names do not need to follow specific strings, as they can be adjusted in the display settings beforehand.
Mutants whose names contain WT (case-insensitive) are treated as controls, and their corresponding group will be ignored. The WT score for each mutant will be set to the average value of all controls.
[image: ]
Figure 62. Settings for Displaying Experimental Results
After adjusting the settings, click “Run” to display the results.
· In the “Mutants” field, specify the location of the CSV file.
· In “Save as”, select the path to save the PyMOL session.
· Leave the Profile path empty and set Profile type to none.
· In the display options below, select from the dropdown menus:
· Group: the column name for classification in your table
· Mut: the column name for mutant names
· Score: the column name for the measured values to display
[image: ]
Figure 63. Mapping experimental data onto the structure
3.3.8 Interact Module (Co-evolution Analysis Module)
In REvoDesign, co-evolution data analysis relies on the GREMLIN algorithm. In this case, the co-evolution computation is stored in the file: gremlin_res/1SUO_A.i90c75_aln.GREMLIN.mrf.pkl.
Users need to go to the Interact tab and provide the path to the GREMLIN archive and the saved path for point mutation designs. Then, adjust the filtering thresholds, such as the top N co-evolving residue pairs based on signal strength, maximum contact distance, and chain-binding status in homologous multimers. If necessary, specialized scoring functions can be applied for point mutation evaluation.
The interface for analyzing global and local co-evolution residue pairs is largely the same. The main difference is that for local co-evolution analysis, the target residue must be selected in PyMOL. This creates a selection named sele in PyMOL; only when this selection is active will the local co-evolution analysis be triggered.
Click Initialize to load the GREMLIN archive and generate a 2D contact map showing the co-evolutionary signal strength between residue pairs.
· Global Co-evolution Residue Analysis
[image: ]
Figure 64. Interface for Co-evolution Analysis
After the co-evolution calculation archive is loaded, click “Scan” to analyze the spatial positions of co-evolving residue pairs and the distribution patterns of all 20 amino acids.
For example, in this demonstration, the top 100 global co-evolving residue pairs were selected, with a distance filter of 20 Å. The scan results are visualized as backbone-connected sticks: blue sticks represent residue pairs, yellow sticks indicate the currently analyzed pair, and the stick thickness reflects the strength of the co-evolutionary signal.
[image: ]
Figure 65. Search of global co-evolving residue pairs
Users can click “Previous” or “Next” to step through co-evolving residue pairs. The interface simultaneously updates the MRF (Markov Random Field) matrix for each residue pair. The horizontal and vertical axes represent the 20 standard amino acids plus deletions at each residue. Each cell corresponds to a specific residue combination, with the cell color reflecting the probability of that particular substitution according to the chosen color scheme.
Every cell acts as a point-mutation design button. Clicking a cell will instantly generate a virtual mutant, which goes through a workflow including mutant construction, side-chain modeling, scoring evaluation (if enabled), or assigning the corresponding MRF score from GREMLIN, followed by grouping and display in PyMOL.
When the cursor hovers over a cell, a crosshair pointer appears, indicating the mutation being designed at the two residues. Additionally, a floating label shows detailed mutation information. Cells corresponding to the wild-type (WT) residues indicate the original residue combination for the co-evolving pair.
[image: ]
Figure 66. Real-time co-evolution analysis
[image: ]
Figure 67. Designing point mutations in coevolution analysis
· Local Co-evolutionary Residue Analysis
Compared to global co-evolutionary residue analysis, local analysis has the following additional triggering conditions:
1. Click on a residue in PyMOL, which will automatically generate a selection object named sele.
2. The sele object must be in an enabled state.

For the user, a single click on the structure is sufficient. If using a PyMOL script to make the selection, it must be done as follows:
```pymolscript
select sele, 1SUO and resi 298
enable sele
```
Then click “Scan” to perform the analysis for that specific residue (e.g., residue 298).
[image: ]
Figure 68. Local coevolution analysis settings
[image: ]
Figure 69. Search results for local coevolution residue pairs
[image: ]
Figure 70. Designing mutations for residue 367
Mutations designed based on GREMLIN need to be saved by clicking “Accept” in the interface, or by going to the Evaluate module for rational assessment and saving.
3.4 Other Design Features
[bookmark: _Toc207024885]3.4.1 Profile Design
Profile Design is located in the design tools section of the menu bar. Its purpose is to perform free design on user-specified target residues by referencing particular design datasets such as PSSM, ESM1v, or Pythia-ddG.
Similar to the button matrix in co-evolution analysis, Profile Design features a hovering crosshair pointer and allows direct mutant generation by clicking buttons. In the design window, the horizontal axis represents residue numbers, and the vertical axis represents the 20 standard amino acids; the WT amino acid of each residue is labeled with its single-letter code.
Profile Design requires the current structural model to be loaded in REvoDesign. Additionally, because it involves side-chain modeling and mutant display, the main interface’s color presets, color preset inversion, and side-chain solver settings will be applied during the design process.[image: ]
Figure 71. Entry point for Profile Design
[image: ]
Figure 72. Input fields for Profile Design
Tip: All residue range inputs in REvoDesign support both file input and string input. For example, in the input field shown in Figure 72, 200-300 indicates all residues from 200 to 300. Single residues can be specified with individual numbers (e.g., 188), continuous ranges with a hyphen connecting the start and end (e.g., 200-300), and non-continuous ranges can be combined using commas (e.g., 99,188,200-300).
[image: ]
Figure 73. Interface of Profile Design
Clicking on a grid corresponding to an amino acid of interest will trigger the side-chain modeling and mutant display workflow.
[image: ]
Figure 74. Profile Design performs free point mutation design on residues of interest.
[bookmark: _Toc207024886]3.4.2 ThermoMPNN
ThermoMPNN is a tool that predicts the effect of mutations on protein thermostability, supporting both single-point and double-point (higher-order) predictions. Users can access it from the corresponding entry in the menu bar.
[image: ]
Figure 75. ThermoMPNN menu entry
[image: ]
Figure 76. ThermoMPNN single-point scan settings
Note that when top_ranked is set to its default value of -1, all results will be displayed. For large mutant libraries, particularly in the case of double mutants, this may impose unnecessary computational overhead. It is therefore advisable to restrict the output to a smaller set, such as 100–200.
In addition, ThermoMPNN outputs predicted ddG values, where lower scores correspond to increased stability. Accordingly, the option to invert the color scale should be enabled.
[image: ]
Figure 77. Single-point design demonstration of ThermoMPNN
[image: ]
Figure 78. ThermoMPNN design of double-point mutations
Additive means addition; epistatic means taking into account epistatic effects.
[image: ]
Figure 79. Two-point combination design of ThermoMPNN


3.4.3 RFdiffusion backbone masking design
[image: ]
Figure 80. RFdiffusion entry in the menu bar
[image: ]
Figure 81. RFdiffusion parameter settings
For example, in the structure of 1SUO, a loop region was identified that protrudes beyond the resolved model. The aim is to refine the backbone coordinates and sequence of this segment.
To this end, we constructed the task file partial.yaml, the content of which is as follows:
```yaml
defaults:
  - base
inference:
  output_prefix: /Users/yyy/Documents/projects/REvoDesign/userguide/example/output/rfd/res/1SUO_partial
  num_designs: 1
  input_pdb: /Users/yyy/Documents/projects/REvoDesign/userguide/example/output/temperal_pdb/seg_chain_resn_sel/1SUO.pdb
contigmap:
  contigs: 
    - 20-20/A48-492
diffuser:
  partial_T: 10
```
In this configuration, we specified the use of the baseline model to apply local diffusion to the first 20 amino acids of 1SUO, thereby refining the backbone coordinates, while leaving the remaining residues unchanged.
[image: ]
Figure 82. RFdiffusion calculation results display
The original structure is shown in gray, while the redesigned structure is depicted in brick red. Following structural superposition, the backbone of the N-terminal region is observed to be refined.
For additional application scenarios, users are referred to the RFdiffusion documentation.

3.5 [bookmark: _Toc207024889] About Rosetta Installation
Certain functions of REvoDesign rely on Rosetta, which requires the availability of functional binary files on the user’s system, obtained either through local compilation or by pulling a precompiled Rosetta image from Docker. The interface between REvoDesign and Rosetta is facilitated by the RosettaPy project (see: https://github.com/YaoYinYing/RosettaPy).
Prior to using Rosetta-related modules, users should select the appropriate Rosetta Node in the configuration, based on their system environment.
	Rosetta Node
	Definition

	`native`
	Locally compiled, non-MPI version

	`mpi`
	Locally compiled, MPI version

	`docker`
	Docker image, tagged as latest

	`docker_mpi`
	Docker image, tagged as mpi


It is recommended that Windows users employ Docker containers, while macOS and Linux users may utilize either precompiled binaries or locally compiled versions.

3.6  Compilation of References Related to the Use of Third-Party Functionalities
The execution of third-party tools automatically collects the corresponding citation data. Upon completion, a date-stamped file with the .bib extension will be generated in the citation folder of the working directory, containing the references for the modules employed. If users intend to include results generated by these tools in their research and plan to publish, the relevant references in this file should be appropriately cited.
Furthermore, certain tools used to generate the corresponding reference data may not have their references included in the .bib file; nevertheless, users should ensure that these tools are properly cited.
IV. Other tool integrations
The integration of third-party design tools entails substantial adaptation efforts, including performance analysis, resource utilization assessment, evaluation of integration complexity, resolution of dependency conflicts, middleware integration, and incorporation into REvoDesign’s built-in interfaces. The level of difficulty varies depending on the specific case.



1

image3.png
r. [ ] Select plugin directory h

In which directory should the plugin be installed?

[Users/yyy/.pymol/startup
cancel

u 4




image4.png
Display

Setting Scene Mouse  Wizard

Plugin  Help

PyMOL

bin/python3.11 -m ensurepip

[INFO]: [STDOUT] Looking in links: /var/folders/rb/q92dv@b127s6pztl7kwk]
T/tmp6kuci3u?

[INFO]: [STDOUT] Requirement already satisfied: setuptools in ./miniforg
envs/REvoDesignLatestDev/1ib/python3.11/site-packages (78.1.1)

[INFO]: [STDOUT] Requirement already satisfied: pip in ./miniforge3_py31
REvoDesignLatestDev/1ib/python3.11/site-packages (25.2)

PyMOL> |

10

Open-Source

PyMOL™

by SCHRODINGER

Unofficial PyMOL™ Executable - Copyright © Schrddinger, LLC

To obtain official PyMOL builds with maintenance and support,
please visit the project home page at: https://pymol.org

Plugin Manager
Legacy Plugins
Caver NG
REvoDesign

Lighting Settings
APBS Electrostatics

1t Draw/Ray

>
ck  Get View
> >| MClear
s Rebuild





image5.png
REvoDesign Package Manager

Makes enzyme redesign tasks easier to all.

Source:

Repository Local Directory ) Local file Install

[Users/yyy/Downloads/REvoDesign-1.8.1.tar.gz

Remove
Options:

Verbose:

Upgrade

Network:

proxy

Mirror
Extras:
Refresh None () Customized Everything
Cache:

Use:

DLPacker
PIPPack

ColabDesign

ThermoMPNN

ESM1/2

OpenMM

RFdiffusion (MPS)
RFdiffusion

Test




image6.png
[ ] REvoDesign Package Manager

Makes enzyme redesign tasks easier to all.

Upgrad his manager

Source:
Refresh GitHub Release tags
Reposit . . Install
Collect diagnostic data (reduced)
|Usersfyyy/Dc  Collect diagnostic data (full, non-sensitive) =~ Remove
Collect diagnostic data (full, with sensitive)
Options:
Reset REvoDesign's Configuration
Upgrade  Verbose:  wewwex
Network:
proxy:
Mirror:
Extras:
Refresh None () Customized Everything
Cache:

Use:

DLPacker
PIPPack

ColabDesign

ThermoMPNN

ESM1/2

OpenMM

RFdiffusion (MPS)
RFdiffusion

Test




image7.png
Source:

Repository

Makes enzyme redesign tasks easier to all.

Local Directory

® |ocal file

/Users/yyy/Downloads/REvoDesign-1.8.1.tar.gz

Options:

[}
v Upgrade

Network:

proxy

Mirror
Extras:
Refres
Cache:

Use:

{

"Platform::
"Platform:
"Platform:
"Platform::
"Platform::

Install

Remove

DLPacker
PIPPack

Issue collection copied to clipboard. Please
paste it in a new issue in the REvoDesign

repository on GitHub.

Hide Details...

Platform": "darwin",
64bit",

:Architecture
:0S": "Darwin",
MacOS::Version": "15.5"
Release": "24.5.0",

ColabDesign

1ermoMPNN

<
=
=
N}

penMM

=diffusion (MPS)
Fdiffusion

ist




image8.png
-
[ XN ] @ REvoDesign - PyMOL Interface

1\Aolecule: 1SUO [ Chain: A 2CPUS: 102

4 Mutate Evaluate Cluster  Visualize Interact Socket Config

Functional pocket options

Substrate: | (2 radius: 8.0A

Cofactor: radius: 7.0A

Save as:

Surface exposure options
Chain Dist.: 3.0A £  Exclusion:

Find Exposure areaz 15.0A2 Refresh Selection

Save as:





image9.png
-
[ X X ) @ REvoDesign - PyMOL Interface - as
Molecule and Chain Parallelism ' Reds_r

[" Spectral_r
Molecule: 1SUO Chain: A CPUs: 102 I Wistia_r

" YiGn_r

Mutate  Evaluate  Cluster  Visualize  Interact  Sc¢ I YiGnBu_r

. . ¥ YIOrBr_r
Functional pocket options ' YIOrRd_r
A afmhot_r
Substrate: radius: 8.0A o
| autumn_r
Cofactor: radius: 7.0A T [ binary_r

|l bone_r
brg_r
Save as: . 9
[ cool_r

[" coolwarm_r
|l copper_r
|l cubehelix_r
i flag_r

|l gist_earth_r
(ol gist_gray_r
|l gist_heat_r
Save as: - P gist_ncar_r
¥ gist_rainbow_r
| gist_stern_r
¥ gist_yarg_r
‘VCoIor map. ‘ |l gnuplot_r

Surface exposure options
Chain Dist.: 3.0A £  Exclusion:

Find Exposure areaz 15.0A2 Refresh Selection





image10.png
& python3.1

Molecule and Chain

Molecule: 1SUO

Functional pocket options

Edit  Style

® REv¢

Evaluate

Substrate: |

Cofactor:

Tools Help About
Design Tools >
Small Molecule Tools > Color Map
~ Structure Tools > = - P
1 Rosettaligand
Predictor Tools > FastRelax
Molecular Dynamics > Relax w/ Ca Constraints
Modeling Tools >
Rosetta Score Analyser
Export > .
Backbone Rebuild > o v
WA T

@ Editor Backend > F





image11.png
[ XN ] RelaxWithCaConstraints

Perform Rosetta Relax With Ca Constraints

Field Type Input Action
* pdb str  Required Browse
* nstructs_per_roundint 1 1 <
* ncycles int 3 Number of structuies to generate per round.
* save_dir str  relaxed Browse
* job_id str ix_w_ca_constraints
ligand_params str Browse
opts str
load_to_preview bool

Load Save

OK Cancel




image12.png
[ XN ] RelaxWithCaConstraints

Perform Rosetta Relax With Ca Constraints Yesterday { imetadata"s {
" _window__":
"RelaxWithCaConstrai
Field Type Input Action "__version
"__date__"
* pdb str  Required Browse 16:2‘}5:49
"__asked_values_ ": {
* nstructs_per_roundint 1 < "pdb": “/Users/yyy/
Documents/projects/REvoDesign/
L ~ userguide/example/output/pdb/
* ncycles int 3 > 1SU0_apo. pdb",
“nstructs_per_round": 4,
. " les'T 3,
* save_dir str  relaxed Browse 2;5;_3? "relaxed",
"job_id":
* job_id str ix_w_ca_constraints 'Ela"-”w??;iﬁﬂsﬁiiiﬂﬁﬁ
ligand_params str Browse
relax.ca.cst.json
opts str JSON - 494 bytes
Information
Load Save Created Yesterday, 16:26
OK Cancel

More...




image13.png
& python3.11 | File Edit Style Tools Help About

[ XN ] Import PyMOL Session DL Interface
Molecule and Chain | Set Working Directory Parallelism Color Map
Molecule: 1SUO  Experiment > | CPUs: 105 Fibwr_r

Recent Experiments

| e ~*aract Socket Config

Language > | V English
Functional pocket ¢ Chinese {

— R | chinese
Substrate: || Close jmer reuus. 8.0A
Cofactor: radius: 7.0A Z




image14.png
& python3 1 X8 H#E Rt IBR #®EB XT

[ BON ] ® REvoDesign-PyMOL FBF"
ERS TR FTIHE Eeammig
EBHF:  1SUO g A gog: 100 Fabwrr

RE TME RE BRI ##  ER  BE
A OREE
By | ¥z 8.0A
s

<> <>

w2 7.0A

REA:

RERBUSEE

SHESEE: 3.0A I HHS:

ki Exposure areaz  15.0Az RIFRI%EIR

REA:





image15.png
@ python3.11 File Edit Style Tools Help About

[ XN ] Import PyMOL Session DL Interface
Molecule and Chain Set Working Directory Parallelism Color Map
Molecule:  1SUO  Experiment > | Load S8L Flibwr_r
Recent Experiments Save to ...
uanze nteract Socket Config
| Language > F

Functional pocket ¢
Log File >

ubstrate: ) radius: 8.0A C
iz | Close di 8.0A

-~ f . s YT ey A




image16.png
& python3.11 File Edit Style Tools Help About

[ BON ] Reconfigure lerface

Molecule and Chain 5 . . Parallelism Color Ma|
Edit Configuration R

Molecule: 1SUO I Save Configurations ®S CPUs: 10 Fibwr_r

Save Configuration as

Mutate Interact Socket Config
| Environment Variables > |
Functional pocket options
Reinitialize
Substrate: || AutoFill > radius: 8.0A
Cofactor: Start Dictation radius: 7.0A ' C

Emoji & Symbols





image17.png
-
[ BON ] @ revodesign.yaoyy.moe/PSSM X o

<« > C m 25 revodesign.yaoyy.moe/PSSM_GREMLIN/create_task Y ) (3 Q
REvoDesign: Create a new task of PSSM_GREMLIN Dashboard Document GitHub
Upload a File

Choose File [1SUO_A fasta Upload

{"md5sum":"1c0c81327e86851981a4021b8d46f448","status":"still running"}




image18.png
-
[ XK ) @ REvoDesign: PSSM_GREMLII X 4+

< C M 25 revodesign.yaoyy.moe/PSSM_GREMLIN/dashboard Y 3 (<
REvoDesign: PSSM_GREMLIN Task Submission Panel Create New Task Document GitHub
Task file: Task MD5: Status:Submited: Finished: Task
1SUO_A fasta1c0c81327e86851981a4021b8d46f448running2025-08- - Summary
13 Total
17:32:32 tasks: 31
In
running: 1
e B il el " ol Bl " e
n =u HE N = I H = & I | | w 0

| |
_ - e e e ——— e — e o ERECE. _ rciniched-




image19.png
[ XK ) @ REvoDesign: PSSM_GREMLII X 4+

& C Mm 25 revodesign.yaoyy.moe/PSSM_GREMLIN/dashboard i ¢ o3 (3 Q
REvoDesign: PSSM_GREMLIN Task Submission Panel Create New Task Document GitHub
Task file: Task MD5: Status:Submited: Finished: Task
1SUQ_A fasta1c0c81327e86851981a4021b8d46f448running2025-08- - Summary
13 Total
17:32:32 tasks: 31
In
Sequence: >1SUO_A running: 1
XXX XXXXXXXXXXXXGKLPPGPSPLPVLGNLLQMDRKGLLRSFLRL In queue:
Wall time: - 0
= Finished:
30

Cancelled:

n




image20.png
[ XK ) @ REvoDesign: PSSM_GREMLII X 4+

& C M 25 revodesign.yaoyy.moe/PSSM_GREMLIN/dashboard * o3 R Q
tasks: 32
In
Task file: Task MD5: Status: Submited:Finished: running: 1
1SUO_A fasta1c0c81327e86851981a4021b8d46f448finished2025-08- 2025- In queue:
13 08-13 0
17:32:32  18:06:10 Finished:
31
Sequence: >1SUO_A Cancelled:

XXXXXXXXXXXXXXXXXXXXXXXXXXXGKLPPGPSPLPVLGNLLQMDRKGLLRSFLRL 0
Wall time: 2018 Failed: 0




image21.png
[ XN ] PyMOL (1SUO.pze)

AssignSS-Warning: Ignoring incomplete residue /1SUO/A/A/495 ... Reset Zoom Orient Draw/Ra
PyMOL>remove r. HOH

Remove: eliminated 190 atoms in model "1SUO".
PyMOL>bg_color white < < Stop Play > >| MClear
Save: Please wait -- writing session file... Builder Properties  Rebuild
Save: wrote "/Users/yyy/Documents/projects/REvoDesign/userguide/example/output/

analysis/1SU0.pze".

Unpick Deselect Rock Get View

PyMOL> |

10




image22.png
@ python3.11 File Edit Style Tools Help Abo

[ XN ) Impi\rt PyMOL Sessiol -\ DLInterface
Molecule and Chain Set Working Directory Parallelism Color Map
Molecule: | Experiment > | CPUs: 10 C Fibwr_r

Recent Experiments

| ualize Interact Socket Config

Language >

Functional pocket ¢
Log File >

Substrate: | Close radius: 8.0A

Cofactor: radius: 7.0A

<>

<>

Save as:

Surface exposure options
Chain Dist.: 3.0A £  Exclusion:

Find Exposure areaz 15.0A Refresh Selection

Save as:





image23.png
FXX ) @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO [ Chain: A CPUs: 10 C Fibwr_r

Mutate Evaluate Cluster  Visualize Interact Socket Config

Functional pocket options

Substrate: radius: 8.0A
Cofactor: | cpz radius: 7.0A Z
HEM

Save as:




image24.png
XX ) @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO Chain: A CPUs: 10 C r‘bwr_r

Mutate Evaluate Cluster  Visualize Interact Socket Config

Functional pocket options

<>

Substrate: CPZ radius: 8.0A

O Detect !
Cofactor:  HEM| radius: 7.0A T

Save as: 1ents/projects/REvoDesign/userguide/example/output/analysis/1ISUO.pocket.pze




image25.png




image26.png
Surface exposure options

Find Exposure areaz 15.0A2 Refresh Selection

Save as:




image27.png
Surface exposure options
Chain Dist.: 3.0A C Exclusion: pkt_hetatm_8.0_01

Find Exposure areaz 15.0A2 Refresh Selection Detect !

Save as: ents/projects/REvoDesign/userguide/example/output/analysis/1SUO.surface.pze




image28.png
[ XN ] PyMOL (1SUO.surface.pze)

REvoDesign/userguide/example/output/analysis/1SUO.surface.pze Reset Zoom Orient Draw/Ra
INFO:REvoDesign.driver.ui_driver:Checking file path: /Users/yyy/Documents/projects/
REvoDesign/userguide/example/output/analysis/1SUO.surface.pze
WARNING:REvoDesign.driver.ui_driver:The file /Users/yyy/Documents/projects/ [< < Stop Play > >| MClear
REvoDesign/userguide/example/output/analysis/1SU0.surface.pze’ is not valid. Builder
surface_cutoff: 15.0

surface_cutoff: 15.0

Unpick Deselect Rock Get View

Properties Rebuild

PyMOL>

ol el o ol el R e G
FHEEEEEEEEEE





image29.png
[ BON ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO [ Chain: A CPUs: 10 C Fibwr_r

Prepare Evaluate Cluster  Visualize Interact Socket Config

Profile: t/PSSM_GREMLIN/pssm_msa/1SUO_A_ascii_mtx_file PSSM
Residue ID: e/example/output/surface_residue_records/1SUO_residues_cutoff_15.0.txt

Save as: Jide/example/output/analysis/design/1SUO.simSER.pze Run!

Score cutoff Design Case

Designer options

-2 <AScoreswwrs 20

Temp: 0.10 £ Homooligomer

Substitutions to:
Num: 10 < De-duplicated

Reject: PC

Accept: E:DATY K:RATY N:ATY Q:EDATY Batch:1 o Random:





image30.png
'Y PyMOL (1SUO.simSER.pze) A
ted at /Users/yyy/Documents/projects/REvoDesign/userguide/example/output/analysis/ Reset Zoom Orient Draw/Ra
design/temp_sessions/mutate_only.1SUO.simSER.pze
INFO:REvoDesign.citations.citation_manager:Citation is created at ./citations/

Unpick Deselect Rock Get View

20250814 .bib |[< < Stop Play > >| MClear
INFO:REvoDesign.tools.utils:Finished Run Mutant Loading from Profile in 13.265 seco Builder Properties Rebuild
nds

PyMOL>bg_color white

PyMOL>

FHEEEEEEEEEEE T

10




image31.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO [ Chain: A CPUs: 10 C Fibwr_r
Prepare Evaluate Cluster  Visualize Interact Socket Config

Profile: t/PSSM_GREMLIN/pssm_msa/1SUO_A_ascii_mtx_file PSSM

Residue ID: ide/example/output/pockets/1SUO_design_shell_CPZ_8.0_01_residues.txt

Save as: example/output/analysis/design/1SUO.design.shell.pze Run!
Score cutoff Design Case
design.shell

-5 s4ascoreswwrs 20

Designer options

Temp: 0.10 £ Homooligomer

Substitutions to:
Num: 10 < De-duplicated

Reject: PC

}.Preferred substitutions. For PSSM and CSV: "E:DATY K:RATY ". For external designers: " DNEQKRHHH".




image32.png
r
o000

PyMOL (1SUO.design.shell.pze) h

cartoon_power
cartoon_power_b
cartoon_putty_quality
cartoon_putty_radius
cartoon_putty_range
parser: no matching setting.
parser: matching setting:

cartoon_tube_cap Reset, Zoom Orient Draw/Ra
cartoon_tube_quality
cartoon_tube_radius
cartoon_use_shader

Unpick Deselect Rock Get View
|[< < Stop Play > >| MClear
Builder Properties Rebuild

cartoon_trace_atoms cartoon_transparency

PyMOL>set cartoon_transparency, .

Setting: cartoon_transparency set to 0.60000.

PyMOL>

oL

a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
a]s]
als]

EIEEIEEIEEIEES EIESEEIEY
ol ol o el S e
FHEEEEEEEEEE T




image33.png
r. [ON | @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO (2 chain: A CPUs: 10 C Fibwr_r
Prepare Mutate Cluster  Visualize Interact Socket Config

Save Mutants: REvoDesign/userguide/example/output/mutant/1SUO.simSER.mutants.txt

Initialize Load Checkpoint Show WT




image34.png
Design Status Choice of Design

j l l mt_E93_7.0 AE93D_5.0
Total: — -l
I— Previous Reject
I-l Next Accept
Selected:
u Find the Best Hit I'm Lucky!




image35.png
PyMOL>

T T T T T > DD D
Loy Ry Ry Ry RN R Ry RN RNy RN ]
I I T T T T T T I I I I I IT T IT IT T

. R




image36.png
r|» o> o> >T> > DD D
LY DD OO OO O
I T T T T T T I I I I I I I I T IT IT T

o Lo [s[ e[+ ]e]s o o]+




image37.png
Design Status Choice of Design

j l l mt_Q204_3.0 AQ204E_6.0
Total: i .l
I— Previous Reject
l Next Accept
Selected:
l Find the Best Hit I'm Lucky!




image38.png
Design Status Choice of Design

 mt_K100_2.0 AK100H_3.0
mt_101_3.0

_ mtA10230
mt_V103_4.0
mt_V104_2.0
mt_D105_5.0
mt_F108_6.0
mt_I209_2.0
mt_E218_3.0
mt_F365_-1.0
mt_V477.1.0
mt_G478_5.0

Total:
Reject

Accept
Selected:

==
NN

I'm Lucky!




image39.png
Save Mutants: REvoDesign/userguide/example/output/mutant/1SUOQ.sil

Initialize

Design Status

Total: l I-l :l

B | | g
Selected: l :l
| I

Load Checkpoint

Choice of Design

mt_K100_2.0

Previous

Next

Find the Best Hit

AK100A_-1.0
AK100R_1.0
AK100N_0.0 WT
AK100D_1.0
AK100Q_0.0
AK100E_2.0
AK100G_-2.0

 AK100H_3.0 [

AK1001_-2.0
AK100L_-3.0
AK100M_-2.0
AK100F_-3.0
AK100S_2.0
AK100T_1.0
AK100Y_-1.0
AK100V_-2.0

I'm Lucky!




image40.png
5 ©
8
< - = -
%) Q >
B4
S| = ] 8 9
— e a
< I Q
S < £
o
N
(¢
<
€
S <>
g © .
8 0 =
5] = 2 3
] c ) m .n @
@ &= | (1) ]
3 » o = <
2 & 3 d o H
s 9 o c
o~ i
.m €
<
3}
l-l ——
-
° — -L
N
8
£

Total:
Selected:

Design Status

CERRRRREEREREEREEEEEE
[ e T R
=l=[=[z[=z[z][=[z[=[=[=z[z[z[=[z[=]z[=]=]
0 e e I ) R R
BEEEEEEEEEEEEEEEEEE





image41.png
Initialize Load Checkpoint Show WT

Design Status Choice of Design

l mt_Q239_3.0 AQ239E_3.0

Total:

l-:_l

Previous Reject

Next Accept
Selected:

Find the Best Hit I'm Lucky!

BEEEE B B B E N EE EIEI ENE B
N ) ) ) A ) A )
EIEE3Ea e B e e e E e E e ER ESER EY
T ) e e = e = = e = e = = = = =

IC
5
e
e
L
e
C
L
e
e
e
e
L
e
C
L
e
e
e
e





image42.png
Design Status Choice of Design

j l l mt_Q239_3.0 AQ239E_3.0
Total: i .l
I— Previous Reject
l I- Next Accept
Selected: -—
l J Find the Best Hit I'm Lucky!




image43.png
>  mutant =y By D¢ B2 O ®@ W Mh Q
Today Today AE93D
AK191R
[ analysis > B 1SUO.simSER.mutants.txt AQ204E
AQ239E
[ citations > [ checkpoints > Agmy
i AQ247E
[ experiment > AK251R
= mutant B AQ286E
AE322A
2 mutant_pdbs > AE329D
: : . AK345R
[ mutations_design_profile > AK373R
db > AN406Y
=e ) AE424D
[ recipe > AE474A
[ relaxed >
[ seg_chain_resn_sel > 1SUO.simSER.mutants.txt
[ temperal_pdb > text - 103 bytes

Trnfmreree adimm




image44.png
o
o
o

M E®S ©@ ® W h Q

ill
<
|

<

checkpoints

o
o
o

Today Today AE93D_5.0
AK191R_1.
= 1SUO.simSER.mutants.txt = ckp_2025081...R.mutants.txt AQ204E_6.

AQ239E_3.
72 checkpoints > B ckp_2025081...R.mutants.txt A2240Y_3_

AQ247E_6.
AK251R_0.
AQ286E_5.
AE322A_5.
AE329D_8.
AK345R_3.
AK373R_5.
AN406Y_0.
AE424D_7.
AEA74A_1.

ckp_20250814_170637.1-
SUO.simSER.mutants.txt
text - 163 bytes

ERCRCRCRCE R R R R RN RN

Information




image45.png
Initialize Load Checkpoint Show WT

Design Status Choice of Design

l l mt_E93_7.0 AE93D_5.0

I

Total: -—
l Previous Reject
l Next Accept
Selected:
l Find the Best Hit I'm Lucky!




image46.png
r. [ON ] PyMOL (1SUO.simSER.pze)

INFO:REvoDesign.evaluate.evaluator:Progressbar set to @: AE93D_5.0
INFO:REvoDesign.evaluate.evaluator:Jump to AE93D_5.0 as required.
INFO:REvoDesign.evaluate.evaluator:Progressbar set to @: AE93D_5.0
INFO:REvoDesign.evaluate.evaluator:Recover mutants from checkpoint: /Users/yyy/
Documents/projects/REvoDesign/userguide/example/output/mutant/checkpoints/
ckp_20250814_170251.1SU0.simSER.mutants . txt
INFO:REvoDesign.evaluate.evaluator:['AQ204E_6.0"]




image47.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO Chain: A CPUs: 10 C r‘bwr_r

Prepare Mutate Evaluate Visualize Interact Socket Config
Calculating options

Mutants: simSER.mutants.txt

12 <sNumpurs 1 C

Z Batch: 100 O

Matrix: = PAM30

Clusters: 5

Shuffle Mutate Relax





image48.png
Prepare Mutate Evaluate Visualize Interact Socket Config
Calculating options

Mutants: simSER.mutants.txt

17 <Num Mmuts 1 <

Clusters: 5 C Batch: C

Matrix: = PAM30

Shuffle Mutate Relax

Run!





image49.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO [ Chain: A CPUs: 10 C Fibwr_r

Prepare Mutate Evaluate Visualize Interact Socket Config
Calculating options

Mutants: simSER.mutants.txt

12 <sNumpurs 1 C

Clusters: 5 ' Batch: 100

Matrix: = PAM30

Shuffle Mutate Relax

Run!




image50.png
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:
INFO:

REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.

REvoDesign.
REvoDesign.
REvoDesign.
REvoDesign.

clusters.
.score_clusters:Cluster @ - E474A.1SU0 : -998.38

.score_clusters:({'score': -998.38, 'decoy': 'E474A.1SU0'},)
clusters.
clusters.
.score_clusters:Cluster 1 - E240Y.1SUO : -985.827

.score_clusters:({'score': -985.827, 'decoy': 'E240Y.1SU0'},)
clusters.
clusters.
.score_clusters:Cluster 2 - Q247E.1SU0 : -1000.27
.score_clusters:({"'score': -1000.27, 'decoy': 'Q247E.1SU0'}, {'score': -995.482, 'decoy': 'Q286E.1SU0'}, {'score':
clusters.
clusters.
.score_clusters:Cluster 3 - N40Q6Y.1SUO : -993.626

.score_clusters:({"'score': -993.626, 'decoy': 'N4@6Y.1SU0'},)
clusters.
clusters.
.score_clusters:Cluster 4 - E322A.1SU0 : -992.454

.score_clusters:({"'score': -992.454, 'decoy': 'E322A.1SU0'},)
clusters.

clusters
clusters

clusters
clusters

clusters
clusters

clusters
clusters

clusters
clusters

clusters.

SCOre_ClUSterS === === o m e e e

SCOre_ClUSterS === === o m e e e
SCOre_ClUSterS === === o m e e e

SCOre_ClUSterS === === o m e e e
SCOre_ClUSterS === === o m e e e

SCOre_ClUSterS === === o m e e e
SCOre_ClUSterS === === o m e e e

SCOre_ClUSterS === === o m e e e
SCOre_ClUSterS === === o m e e e

SCOre_ClUStEENS i === === = o m o e e e e
score_clusters:Saving cluster scores to cluster.1SUO_A_1SUO.simSER.mutants_designs_1_rosetta.xlsx/csv

citations.citation_manager:Citation is created at ./citations/20250814.bib
tools.utils:Finished Clustering in 48.332 seconds

-994.775,

'decoy':

'Q204E.1SU0'D)




image51.png
&

@ @ cluster.1SUO_A_1SUO.simSER.mutants_designs_1_rosetta.xlsx M  Open with Microsoft Excel

otal_score| dslf_f313| fa_atr | fa_dun | fa_elec ||_intra_rep||_sol_xover* fa_rep fa_sol mnd_bb_s#bond_lr_bq hbond_sc :ond_sr_bﬂk_ball_md omega p_aa_pp | pro_close ma_preprd ref |h _planarityilescription| branch |
0 -998.38 0 -2855.424 762.402 -795.821 5.815 98.659 369.613 1774.925 -87.002 -42.415 -56.007 -216.369 -68.29 7.083 -82.018 7.993 28.273 150.182 0.02 E474A.1SUCc.0
0 -985.827 0 -2859.267 764.351  -792.042 5.848 99.098 372351 1779.237 -85.227 -42.393 -54.233 -216.37 -68.999 7.083 -81.184 7.983 28.477 149.439 0.02 E240Y.1SUQc.1
0 -989.481 0 -2859.958 763.206 -792.848 5.806 98.822 372.061 1783.799 -86.358 -42.393 -55.044  -216.369 -68.278 7.083 -81.866 7.983 28.109 146.753 0.011 K191R.1SUCc.2
1 -992.588 0 -2862.614 764.718 -796.569 5.834 99.396 370.375 1786.758 -85.221 -42.393 -55.957 -216.369 -68.647 7.083 -81.834 7.979 28.1 146.753 0.02 K345R.1SUCc.2
2 -995.482 0 -2860.201 763.833  -795.904 5.832 99.572 369.779 1784.489 -85.223 -42.393 -56.055 -216.344 -68.847 7.083 -81.932 7.982 27.966 144.859 0.02 Q286E.1SU(c.2
3 -1000.27 0 -2857.399 761.208 -794.455 5.82 98.908 366.545 1781.594 -85.22 -42.393 -56.048 -216.366 -68.565 7.083 -81.868 7.986 28.021 144.859 0.02 Q247E.1SU(c.2
4 -994.147 0 -2859.213 762.346  -793.801 5.822 98.548 370.035 1781.704 -85.221 -42.393 -56.03 -216.369 -68.257 7.083 -81.567 8.004 28.43 146.711 0.02 E424D.1SUCc.2
5 -991.356 0 -2859.46 763.792  -793.161 5.817 98.544 370.474 1782.326 -85.236 -42.393 -55.954  -216.367 -68.551 7.083 -81.441 7.992 28.446 146.711 0.02 E93D.1SUO c.2
6 -993.265 0 -2860.985 764.293  -794.642 5.828 98.998 370.052 1784.169 -85.19 -42.393 -55.94 -216.369 -69.278 7.083 -81.868 7.992 28.213 146.753 0.02 K251R.1SUCc.2
7 -993.869 0 -2859.296 763.492 -794.757 5.784 98.938 371.215 1783.267 -85.217 -42.393 -56.294 -216.339 -68.403 7.083 -81.903 8.003 28.073 144.859 0.02 Q239E.1SU(c.2
8 -994.775 0 -2859.761 761.956 -794.262 5.819 98.964 371.992 1783.48 -85.227 -42.393 -56.295 -216.343 -68.685 7.083 -81.879 7.986 27.911 144.859 0.02 Q204E.1SU(c.2
9 -993.772 0 -2860.781 762.517 -795.167 5.823 98.336 370.54 1785.213 -85.222 -42.393 -57.145 -216.369 -68.386 7.083 -81.305 8.305 28.447 146.711 0.02 E329D.1SUCc.2
10 -993.992 0 -2861.206 763.603 -795.971 5.821 99.165 370.351 1785.199 -85.003 -42.393 -56.048 -216.369 -68.823 7.083 -82.131 8.081 27.878 146.753 0.02 K373R.1SUCc.2
0 -993.626 0 -2861.19 762.577 -793.986 5.841 98.894 370.432 1782.13 -85.227 -42.393 -55.938  -216.369 -68.742 7.083 -81.406 8.1 28.493 148.055 0.02 N406Y.1SUCc.3
0 -992.454 0 -2858.639 762.253 -794.32 5.829 98.729 370.116 1780.116 -85.221 -42.393 -55.957 -216.336 -68.469 7.083 -81.759 7.998 28.315 150.182 0.02 E322A.1SUCc.4





image52.png
[ RGN ] <€) YaoYinYing/pythia-wubianlab X +

&« > C M 25 biolib.com/YaoYinYing/pythia-wubianlab/

€) | Q search BioLib Docs Explore Results

YaoYinYing > pythia-wubianlab

Clear
Enter/Upload your structure in PDB format:
Version D Select file Clear file
0.0.5 (12/26/2023) . [Using default file: /input.pdb. To change, select a new file.]

Access

Discoverable Pyth ia

Use from script

Structure-based self-supervised learning enables ultrafast prediction of stability changes upon mutations
@ Python >~ Terminal

™ e o
e o te o on m m




image53.png
Enter/Upload your structure in PDB format:

D select file @ Clear file

X 1SUO0_apo.pdb - 295.45 KB




image54.png
Result Logs Notes Share 4 Download o View files D

using device cpu

1
2 Saved /home/biolib/pythia_wubianlab/save_dir/1SU0_apo_pred_mask.csv , /home/biolib/pythi
3




image55.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO (&) chain: A CPUs: 10 £ Fibwr_r
Prepare Mutate Evaluate Cluster Interact Socket Config

]
Mutants: dJde/example/output/mutant/1ISUO.simSER.mutants.txt Run!

Save Mutants
Save as: examplefoutput/analysisffilter/1ISUO.simSER.ddG.pze

Reduce Session

Profile:  ut/pythia/1ISUO_pred_mask.csv Csv
Visualizing options Multi-mutation Design
./ Bond CA
Global Score Mutants: V|

SC Orientations

Group: imSER.ddG| () ~ [/ External Scorer

#Mut: 5 C#val: 20 T Dist: 30.0A J v @l by seares
Mut:

Score:

H





image56.png
FX X ) @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism

Molecule: 1SUO [ Chain: A CPUs: 10 2

Prepare Mutate Evaluate Cluster Visualize Interact

Sidechain antinna
Dunbrack Rotamer Library

Solver: [ radius: 0.00 T Model:

PIPPack

Rosetta-MutateRelax
Rosetta Lpwe.e

Node native

Color Map
r‘ bwr_r

~
v




image57.png
r. [ N ] PyMOL (1SUO.simSER.ddG.pze)

cartoon_power_b cartoon_tube_quality
cartoon_putty_quality cartoon_tube_radius
cartoon_putty_radius cartoon_use_shader
cartoon_putty_range

PyMOL>set cartoon_transparency, .6

Setting: cartoon_transparency set to 0.60000.

PyMOL>

oL

Y

Reset Zoom Orient Draw/Ra
Unpick Deselect Rock Get View
|[< < Stop Play > >| MClear
Builder Properties Rebuild

r
o
g

el
g
g

o]
g
g

Ta|

o]

el
g
g

el
g
el

L.

N 2 3 ) N ) A ) A ) A A E
EIEE3E3EIEE EEI EREIEEIESER EAERES
o o o ol sl i
FHEEEEaEEEEERERER R





image58.png
.ol ol ol o o . ol o o e, . o )
T e I e
TTTTTTTTTTTTTTTTTT

oL




image59.png
el o, ol ol o o ], ol ol o o, .ol o o ]
T A
TTTTTTTTTTTTTTTTTT

oL




image60.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism

Molecule: 1SUO [ Chain: A CPUs: 10 C

Prepare Mutate Evaluate Cluster Interact

Mutants: t/mutant/filter/1SUO.simSER.ddG-reduce.mutants|txt

Save as: Mmple/output/analysis/filter/1ISUO.simSER.ddG.reduce.

Profile:  ut/pythia/1ISUO_pred_mask.csv Csv

Color Map

Fibwr_r
Socket Config

Run!
Save Mutants

Reduce Session




image61.png
I8
<

M E®S ©@ ® W h Q

> filter = v

o
o
o

Today Today AE93D
AK191R

= 1SUO.simSER.mutants.txt B 1SUO.simSER....e.mutants.txt AQ204E

AQ239E
[ checkpoints > [ checkpoints > Agz47E

y AK251R

= filter > AQ286E
AE322A

AE329D

AK345R

AK373R

AN406Y

AE424D

AE474A

1SUO.simSER.ddG-
reduce.mutants.txt
text - 96 bytes

Information




image62.png
Prepare Mutate Evaluate Cluster Interact Socket Config

]
Mutants: 2xamplefinput/csv/experimetal_data_mock_label.csv Run!

Save Mutants
Save as: e/output/analysis/visualise/1SUO.experi.mock.vis.pze

Reduce Session

Profile:
Visualizing options Multi-mutation Design
./ Bond CA
Global Score Mutants: 9

SC Orientations

Group: group| ~ [/ External Scorer

#Mut: 5 C#val: 20 T Dist: 30.0A @ Color by scores
Mut: | mutant

11}
111}
111}
111}
111}
E

Score:  normalize (<}

Visualize mutants in structure model.




image63.png
e, ol ol o o ], o ol ol o ], Al ol o o ]
T R
EEE e ESE e B N I ES S ES E EY

ium

=]

oL




image64.png
[ XN ] @ REvoDesign - PyMOL Interface

Molecule and Chain Parallelism Color Map

Molecule: 1SUO Chain: A CPUs: 10 C r‘bwr_r

Prepare Mutate Evaluate Cluster  Visualize Socket Config

GREMLIN profile:

O_A.i90c75_aln.GREMLIN.mrf.pkl

put/mutant/1SUO.gremlin.global.txt

Co-evolved Pairs

Dist: 20.0A 'C  Bind ChainsABCD

Top:100 C  Scorer:

Initialize Scan
Previous Next
Reject Accept

Pair: Score:

WT: Mut:

kMutant Table to save.




image65.png
PyMOL>

Lo R RN Ry RN RNy Ry
I T T T T T T T




image66.png
(XX ] ® REvoDesign - PyMOL Interface.

Molecule and Chain Parallelism Color Map

Molecule: 1SUO @ Chain: A CPUS: 10 Flbwrr 6

Prepare  Mutate  Evaluate  Cluster Visualize Socket  Config

A

R

N ) PumutantISUO gremiin giobalxt

c Co-evolved Pairs

o

imm T .

o Dist: 20.0A Bind Chains ABCD

"

H Top:100 T Scorer:

K

& Initialize Scan

£

K Previous Next

T n Reject Accept

w

M Pair: D374-V381,6.5 A Score:3.166

v

- wr: Mut:
ARNDCQEGHI LK M

Inspect co-evolved pairs





image67.png
Molecule: 1SUO [ chain: A

Prepare Mutate Evaluate Cluster  Vis

+ leep_1SU0_01
- D37d_vs_V381
AD374D_AV3B1F_0O

l<<gH40TvMZAC-TIOMmMOO

ARNDCQEGHI LKMFPSTWYV-

2l 1SSl Inspect co-evolved pairs




image68.png
LXK ] @ REvoDesign - PyMOL Interface
PyMOL>

Molecule and Chain Parallelism Color Map.

Molecule:  1SUO © chain: A B CPUs: 10 3 Tlbwrr

Prepare  Mutate  Evaluate  Cluster  Visualize Socket  Config

GREMLIN profil:

UO_A.i90¢75_aln.GREMLIN.mrf.pki

tput/mutant/1SUO.gremlin.local.txt

Co-evolved Pairs

Dist: 20.0A T Bind Chains ABCD

Top:100 ¢ Scorer:

Previous Next
Reject Accept
! Pair: Score:
wT: Mut:

PubOL>_





image69.png
[ XX} @ REvoDesign - PyMC

FLELS Molecule and Chain
Molecule:  1SUO (2 Chain: A
Yy Prepare Mutate Evaluate Cluster  Visi
-
all HEEBn w1
+ leep_15U0_01 R
N
+invalid_cep_15 o
c
Q
E
G H BN | |
H
1
L
K
M
F
[
s
T
w
¥
v

ARNDCQEGHI LKMFPSTWYV-

PyMOL>_




image70.png
Molecule: 1SUO [ chain: A

Prepare  Mutate  Evaluate  Cluster  Vis

o Ii:l i
R
N
+ invalid_ce o
- A298_vs_V367 c
AR298A_AV3ETL_0 Q
L

G H BN m |
o
:
L
K
N
;
i

s |

T |
w
5
v

h il - W

ARNDCQEGHI qKMF PSTWYV-

Inspect co-evolved pairs




image71.png
& python3.11 File Edit Style

DO O @® REvo

Molecule and Chain

Molecule: 1suo

Prepare Mutate Evaluate

Sidechain options

Solver: ' Dunbrack Rotamer Library

Rosetta options

Tools Help About

Design Tools

Small Molecule Tools
Structure Tools
Rosetta Tools
Predictor Tools
Molecular Dynamics
Modeling Tools
Export

Backbone Rebuild

@ Editor Backend

>
>
>
>
>
>
>
>
>

>

§ Profile Dgn

PSSMto CSV »

it Socket Conf




image1.png
@® Plugin Manager
Installed Plugins Install New Plugin Settings About
Install from local file
Choose file...

Install from PyMOLWiki or any URL

Paste a link to a script or plugin, or a PyMOLWiki url which then will be
downloaded and scanned for scripts that extend the PyMOL API

URL: fcOb9c60bf49ea04a550a044/raw/REvoDesign_PyMOL.py Fetch

Install from Repository

http://pldserverl.biochem.queensu.ca/-
https://github.com/Pymol-Scripts/Pymc
http://www.thomas-holder.de/projects/|

Add... Remove Info Install




image72.png
[ N ] Design with Profile

Run mutant design with profile

Field Type Input

* profile str  JO_A_ascii_mtx_file

* profile_type str PSSM
prefer_lower_scorebool
keep_missing bool

residue_range str

view_highlight str orient

<>

view_highlight_nbrint 6

Load

oK

Action

Browse

Browse

Save

Cancel




image73.png
Mutant Profile Matrix: PSSM (/Users/yyy/Documents/projects/REvoDesign/userguide/example/input/PSSM_GREMLIN/pssm_msa/1SUO_A_ascii_mtx_file)

Design with Profiles: 200-300

< <|gg 4 » T T X r T T MmO O U z2 3 >

N . . N
H m N W "
D
o B o :
N : N
N ‘
u oK n n
n L N n ;
5N m F . e .
o |el sl |l :
T
.
[ | | [ I [ | | [ [ I I [N [ I | | [ I | | | [ I | | | [ [ [ | [ | I [
--k;
s B ]
S$213W (12.000) .
20C 201 202 20% 204 20t 20€ 207 20& 20¢ 210 211 212 753 214 215 216 217 218 219 22C 221 222 223 224 225 22€ 227 228 22¢ 23C 231 232 233 234 23t 23€ 237 23& 23¢ 24C 241 242 243 244 24t 24€ 247 24¢

24¢ 2t





image74.png
v
207 208 20¢ 210 211 212 I8 214 215 216 217 218





image75.png
dit Style Tools Help About

[ NN ) Design Tools voDesign - PyMOL Interface

Molecule ¢ Small Molecule Tools Parallelism Color Map

Structure Tools 3 Chain: A CPUs: 102 Fibwr_r

Molecule
Rosetta Tools

>
>
>
>
p Predictor Tools >| Mutant Effects > ‘:ket Config
>
>
>
>

Molecular Dynamics F | ESM-1v

L ]

Load Checkpoint Show WT

Save N Modeling Tools
Export
Backbone Rebuild

@ Editor Backend >

Nacirnn CFaFT

ChAaircre ~f Nacian




image76.png
ThermoMPNN

Perform ThermoMPNN prediction

Field Type
* pdb str
save_dir str
chains str
* mode str

* batch_size int

* threshold float

distance float
ss_penalty bool
device str

load_to_preview bool

top_ranked int

Load

OK

_resn_sel/1SUO.pdb

utput/TMPNN/single
A
single
256

-0.5

5.00 S
mps

100|

All

Action

Browse

Browse

None

Save

Cancel

Invert




image77.png
1L




image78.png
Field
* pdb
save_dir
chains

* mode

* batch_size

* threshold

distance

Type Input
str  _resn_sel/1ISUO.pdb

str  Hut/TMPNN/epistatic

single ~

str v All
additive .

N \/ epistatic <

int 256

float -0.5

<>

float 5.00

Action

Browse

Browse

None

Invert




image79.png
EEEEEEEEEEEEEEEEEEEEEE
T e e e e
TTTTTTTTTTTTTTTTTTTTTT

oL




image80.png
Style Tools Help About

Design Tools > - PyMOL Interface

nd Chain Small Molecule Tools > Parallelism Color Map

1SUO Structure Tools > ‘A CPUS: 10 2 r‘ bwr_r

Rosetta Tools > )

| Predictor Tools > Visualize  Interact  Socket  Config
Molecular Dynamics >

al pocket ¢ \odeling Tools >

| Export > g J_—
te: Backbone Rebuild > | Rrdiffusion > [ ‘
or: Ius: L3 I
© @ Editor Backend > B

Substrate Potential





image81.png
[ XN J Run RFdiffusion

Run General RFdiffusion task.

Field Type Input Action
config_presetstr base
config_file  str userguide/example/output/rfd/partial.yaml Browse
model_name str Base_ckpt

overrides str

Load Save

Save the current values
OK Cancel




image2.png
Installed Plugins Install New Plugin Settings About

Install from local file

Choose file...

Install from PyMOLWiki or any URL

Paste a link to a script or plugin, or a PyMOLWiki url which then will be
downloaded and scanned for scripts that extend the PyMOL API

URL: fcOb9c60bf49eal4a550a044/raw/REvoDesign_PyMOL.py Fetch

Insta [}
ht . 7
A N PyMOL will now download executable code
| ® from the internet! Proceed?

i

Add... Remove Info Install




image82.png
|||\ DD DT
L0000 OO O
I T T T T T T T T T T





